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Câble épanoui de Duet

Manuel de l'utilisateur 
de Duet

CD de logiciels 
Apogee

Câble FireWire d'1 
mètre

Contenu de l’emballage

Duet

Les articles suivants doivent être inclus dans 
votre emballage Duet : 

Duet•	
Câble FireWire d'1 mètre•	
Câble épanoui de Duet•	
CD de logiciels Apogee•	
Manuel de l'utilisateur de Duet•	
2 prise mono 1,4” pour  •	
adaptateurs femelles RCA 
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Présentation de Duet

Niveau d'entrée 
 et de sortie

 Ces témoins 
montrent le niveau d'entrée ou 

de sortie sélectionné avec le 
bouton rotatif.

 

Port FireWire
À l'aide du câble FireWire 
inclus, branchez votre Mac 
ici - Duet est alimenté par la 
connexion FireWire.

Le bouton rotatif
Régler les niveaux ne pourrait 

être plus simple. Pressez le 
bouton rotatif pour sélectionner 
un niveau d'entrée ou de sortie 
à régler puis tourner le bouton 
pour obtenir le niveau désiré.

Câble épanoui d'E/S
À l'aide du câble 
épanoui inclus, branchez 
vos microphones, 
instruments et sorties de 
ligne ici.

Sortie casque 
Branchez vos écouteurs ici.

Alimentation fantôme
Ces témoins indiquent que 
l'alimentation fantôme de  
48 volts est activée sur  
les connexions .
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Guide de démarrage rapide

Configuration système 

Macintosh G4 1G Hz ou plus rapide, PPC ou Intel CPU, 1 Go RAM minimum, 2 Go recommandé,
OS X : 10.4.11 ou supérieur installé, 10.5.3 ou supérieur chaudement recommandé.

Installez le pack logiciel Apogee
Insérez le CD inclus dans votre Mac, double-
cliquez sur l'icône "Duet Software Installer" 
et suivez les instructions à l'écran. Une fois 
l'installation terminée, il sera nécessaire de 
redémarrer votre Mac.

   

Branchez le câble FireWire
Après avoir redémarré votre Mac, branchez le 
port FireWire de la Duet sur un port FireWire 
400 de votre Mac à l'aide du câble fourni. 

Si votre Mac dispose uniquement de ports 
FireWire 800, branchez la Duet avec un câble 
adaptateur FW400/FW800. Veuillez remarquer 
que, dans ce cas, le port FW800 tourne à la 
vitesse d'un FW400. 

 
Étant donné que Duet est alimenté par la 
connexion FireWire, le témoin OUT devrait 
s'allumer aussitôt.

2
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Guide de démarrage rapide

Sélectionnez Duet for Mac  
Sound I/O 
Après avoir branché Duet sur 
votre Mac, la boîte de dialogue 
de gauche apparaît. Cliquez Yes 
pour choisir Duet for Mac sound 
output et input.

Cette sélection peut aussi être 
effectuée dans le panneau 
System Preferences >  
Sound > Output.
  

            

Branchez les écouteurs
Maintenant, branchez les 
écouteurs à la sortie casque de 
Duet, ouvrez iTunes et lancez 
la lecture d'une sélection audio. 
La lecture devrait s'écouter 
dans	le	casque	et	s'afficher	
sur les indicateurs en façade 
de Duet. 

4

3
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Guide de démarrage rapide

Utilisation de Duet avec GarageBand 
                4.0.0 ou supérieur recommandé
 

Dans GarageBand, choisissez GarageBand >
Preferences, cliquez sur l'icône Audio/Midi et 
réglez Audio Output et Audio Input sur Duet.
Cliquez sur l'icône Advanced et réglez la Audio 
Resolution sur Better ou Best.

Choisissez Track > New Basic Track...

Double-cliquez sur l'en-tête de la nouvelle piste 
pour	afficher	le	panneau	Track	Info	;	dans	ce	
panneau, réglez Input Source sur Mono 1 
(Duet) ;	réglez	Monitor	sur	On.

 Pour	ouvrir	le	panneau	de	configuration	Apogee	
Duet de GarageBand, cliquez sur le bouton  
Edit  près du menu Input Source.

Branchez le câble épanoui fourni sur la 
prise E/S de Duet et branchez un micro 
sur la prise    IN-1 XLR.

 

Cliquez au centre 
du bouton rotatif en 
façade jusqu'à ce que 
le témoin IN-1 s'allume, 
puis faites tourner le 
bouton pour obtenir un 
niveau d'enregistrement 
adéquat sur la piste 
activée pour l'enregistrement.

Vous êtes désormais prêt à enregistrer !

5
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Guide de démarrage rapide

Utilisation de Duet avec Logic Pro/
Express

 8.0.2 ou supérieure recommandée

 
Dans le menu Logic Pro, choisissez  

 Preferences > Audio. Cliquez sur l'onglet 
Device, puis sur celle Core Audio.

 

Dans le panneau Core Audio, 
sélectionnez Duet dans le menu Device. 
Sélectionnez 128 dans le menu I/O 
Buffer Size. 

 Choisissez Audio > I/O Labels dans le 
menu Options. Option-cliquez sur le 
premier bouton radio sous la colonne 
Driver’s I/O Labels. Désormais, les 
étiquettes matériel de Duet apparaissent 
dans les sélections d'entrée et de sortie 
de votre session Logic.

Pour contrôler Duet directement depuis 
votre session Logic, choisissez Audio > 
Open Apogee Control Panel dans le menu 
Options.

 Si vous utilisez une application logiciel 
audio compatible Core Audio, utilisez le 
logiciel Maestro d'Apogee (installé dans 
votre dossier Applications lors de  
l'Étape 1) pour contrôler Duet.

6
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Fonctionnement

Les	paramètres	de	Duet	peuvent	facilement	être	modifiés	à	l'aide	de	l'encodeur	du	
panneau	supérieur	ou	des	différents	panneaux	de	configuration	logiciel	décrit	en	page	10.	
Étant donné que plusieurs options sont possibles, vous pouvez choisir les contrôles logiciel 
et matériel qui répondent le mieux à vos besoins. Par exemple, les utilisateurs Logic 
Pro	peuvent	choisir	de	régler	les	niveaux	avec	l'encodeur	en	façade	de	Duet	et	modifier	
les réglages statiques (tels que la sélection d'entrée ou la phase) depuis le panneau de 
configuration	Apogee	dans	Logic	Pro	8.	Pour	plus	de	commodité,	de	nombreux	paramètres	
peuvent	être	contrôlés	depuis	plusieurs	panneaux	de	configuration.	Le	schéma	sur	la	
page 9 indique les paramètres et les fonctions qui peuvent changer d'un panneau de 
configuration	à	l'autre.

Encodeur en façade de Duet
L'encodeur en façade de Duet  fournit un contrôle simple et immédiat pour les paramètres 
de niveau d'entrée et de sortie. 
 Niveau de sortie

Pour changer le niveau de sortie de Duet (par exemple, les niveaux d'écoute 
au casque ou sur les enceintes branchées), pressez et relâchez l'encodeur 
plusieurs fois jusqu'à ce que le témoin OUT LED s'allume. Puis, faites tourner 
l'encodeur pour obtenir le niveau d'écoute désiré. L'encodeur matériel fonctionne 
en parallèle des contrôles de niveau logiciel.

 Niveau d'entrée
Pour	modifier	le	niveau	d'entrée	de	Duet	(par	exemple,	le	niveau	
d'enregistrement des micros et instruments),pressez et relâchez l'encodeur 
plusieurs fois jusqu'à ce que le témoin IN-1 ou IN-2 s'allume.  
Puis, faites tourner l'encodeur jusqu'à ce que le niveau d'enregistrement désiré 
soit obtenu (comme dans votre logiciel d'enregistrement).

 Sorties désactivées
Pour désactiver les sorties ligne et casque simultanément, pressez et maintenez 
enfoncé l'encodeur jusqu'à ce que le témoin OUT	clignote	;	pressez	et	maintenez	
de nouveau pour réactiver les sorties.

 Contrôleur MIDI
L'encodeur peut aussi envoyer des données de Contrôleur MIDI et de Position 
de morceau pour les applications logiciel. Reportez-vous aux pages 16-17 pour 
en savoir plus.
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Fonctionnement

Encodeur 
Matériel 

Duet  

Apogee 
Maestro

Panneau de 
configura-

tion Apogee 
(dans Logic)

Panneau 
Apogee 

Duet dans 
Garage-

Band

Configura-
tion Audio 

MIDI

Préf. du 
système

Gain d'entrée

Contrôle d'entrée - 
Sélection, 48v, 
Groupe, Phase

Contrôle de sortie -  
Atténuation, Mute

Contrôle de sortie - 
Nominal Level

Mélangeur basse 
latence

Fonctions avancées
                 *

Contrôleur MIDI

Fréquence 
d'échantillonnage 
(voir p.10)

Sélectionner Duet en 
tant qu'entrée/sortie 
pour OSX

* Tous sauf Gain Mode



Duet – Manuel de l'utilisateur

10 Fonctionnement

Fonctionnement

Apogee Maestro
Le logiciel Apogee Maestro fournit le contrôle le plus complet de Duet, incluant le contrôle 
de	tous	les	paramètres,	stockage	et	rappel	de	configurations	et	mélange	basse	latence.	
Si	votre	logiciel	d'enregistrement	n'inclut	pas	le	panneau	de	configuration	Apogee,	utilisez	
Apogee Maestro pour réaliser ces réglages.

 Mélangeur basse latence Maestro
 Lors de l'enregistrement, si vous remarquez un délai entre le moment où vous 
 jouez ou chantez une note et celui où vous l'entendez dans votre casque, le 
 mélangeur basse latence de Maestro peut aider. Veuillez-vous reporter aux 
 pages 18-21 pour en savoir plus sur le mélangeur basse latence.  
 Pour une explication complète de Maestro, veuillez-vous reporter  
 aux pages 12-26.

Panneau de configuration Apogee (Logic Pro 8, GarageBand)
Le	Panneau	de	configuration	Apogee,	dans	les	logiciels	GarageBand	et	Logic	Pro	
8 d'Apple, fournit un contrôle des paramètres de Duet et de stockage/rappel des 
configurations.	Les	panneaux	de	configuration	dans	ces	programmes	doublent	tous	les	
paramètres	trouvés	dans	le	Panneau	de	configuration	Maestro.

Préférences du système OS X
La fenêtre System Preferences Sound d'OS X fournit les paramètres pour sélectionner Duet 
for Mac sound input and output. Si vous n'avez pas sélectionné Duet for Mac sound I/O lors de 
l'étape 3 du guide de démarrage rapide, vous pouvez le faire dans cette fenêtre. 
	 Choisissez	Apple	menu	>	System	Preferences;
	 Ouvrez	la	fenêtre	Sound	preference	en	cliquant	sur	l'icône	haut-parleur	;
	 Cliquez	sur	l'onglet	Output	et	sélectionnez	Duet	dans	la	fenêtre	Device	;
 Cliquez sur l'onglet Input et sélectionnez Duet dans la fenêtre Device.

Configuration Audio MIDI OS X
La	configuration	Audio	MIDI	OS	X	(dans	le	dossier	Applications/Utilities)	fournit	un	contrôle	
sur le niveau de sortie et la fréquence d'échantillonnage de Duet, ainsi que des options de 
configuration	pour	sélectionner	Duet	en	tant	qu'entrée	et	sortie	du	Mac.	Pour	contrôler	le	
niveau de sortie de Duet, la désactivation depuis AMS ou depuis le clavier du Mac, réglez 
Default Output sur Duet.

Réglage de la fréquence d'échantillonnage
Duet fonctionne à toutes les fréquences d'échantillonnage entre 44.1k et 96k. 
La fréquence d'échantillonnage est, dans la plupart des cas, déterminée par 
l'application audio avec laquelle Duet communique. Par exemple, lorsque vous 
utilisez Duet avec GarageBand, la fréquence d'échantillonnage de Duet est 
automatiquement	fixée	à	44.1k	pour	correspondre	à	celle	des	morceaux	dans	
GarageBand. Pour les applications audio qui n'incluent pas de réglage de 
fréquence d'échantillonnage, telles qu'iTunes, la fréquence de Duet peut être 
réglée dans Audio Midi Setup.
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Apogee Maestro

Préférences du système OS X

Panneau de configuration Apogee

Configuration Audio MIDI OS X
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Contrôle Maestro - Niveaux

Menu Interface
Quand Duet est correctement détecté par Maestro, Duet ainsi que le numéro de série 
de l'unité apparaissent dans ce menu.

Identify Unit
En	cliquant	sur	ce	bouton,	vous	pouvez	vérifier	que	la	communication	est	établie	entre	
le logiciel Maestro et Duet (les témoins en façade s'allument). Cliquez de nouveau sur 
ce bouton pour revenir à la fonction normale des témoins de Duet.
 
Input 
Ce menu est utilisé pour sélectionner le connecteur d'entrée et le niveau :

XLR Line +4dBu – Réglez Input sur XLR Line +4dBu si vous avez branché 
une entrée de ligne de niveau professionnelle, telle qu'une console de 
mixage pro, sur les prises  IN (XLR).
XLR Line –10 dBV – Réglez Input sur XLR Line -10dBV si vous avez 
branché une entrée de ligne de niveau consommateur, telle qu'un lecteur 
CD, sur les prises  IN (XLR).
XLR Mic – Réglez Input sur XLR Mic si vous avez branché un microphone 
sur les connecteurs  IN (XLR). Le gain est réglable entre  
10 et 75 dB.
Instrument – Réglez Input sur Instrument si vous avez branché une guitare 
ou un clavier sur les prises   IN (1/4”)	;	le	gain	est	réglable	entre	0	et	
65 dB. Il est aussi possible de brancher des lecteurs CD et autres dispositifs 
de niveau consommateur (-10 dBV) sur ces entrées.

Quand Input est réglé sur XLR Mic ou Instrument, les contrôles suivants sont 
accessibles :

Group – En cochant l'une ou l'autre de ces cases, vous regroupez les 
paramètres de gain de ces deux entrées, de façon à ce que l'encodeur 
matériel ou l'un des encodeurs logiciel contrôle les gains des deux entrées 
simultanément. Si un décalage de gain existe entre les entrées quand 
Group est cochée, le décalage est préservé. 
Bouton logiciel de niveau d'entrée – Le gain de chaque entrée peut être 
contrôlé par ces boutons logiciel. input level control Le niveau de gain est 
indiqué dans la boîte sur la droite du bouton.
Icône de phase – En cochant cette case, vous inversez la polarité du 
signal d'entrée. Dans certains cas, quand deux micros sont utilisés sur une 
source, l'inversement de la polarité d'un micro peut offrir un son plus riche. 
Par exemple, lorsque vous placez des micros au-dessus et au-dessous 
d'une caisse claire, un son plus riche est obtenu quand la polarité du micro 
inférieur est inversée.
48V – En cochant cette case, vous activez l'alimentation fantôme 48 volts 
des connexions XLR. Les micros à condensateur requièrent l'alimentation 
fantôme pour fonctionner. 

Maestro

1

2

3

4

5

6
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Level 
Le niveau nominal ou moyen des sorties de ligne est réglé dans ce menu :

Line out – Réglez Level sur Line out quand vous branchez les 
connecteurs OUT-L  ou OUT-R de Duet sur des enceintes alimentées, un 
système	hi-fi	ou	une	console	de	mixage.
Instrument Amp – Réglez Level sur Instrument Amp quand vous 
branchez les connecteurs OUT-L  ou OUT-R de Duet sur une entrée 
d'ampli	d'instrument.	Le	niveau	de	sortie	est	fixe.

Bouton logiciel de niveau de sortie
Le niveau des sorties casque et ligne est contrôlé simultanément avec ce bouton 
logiciel quand Level est réglé sur Line out. Le niveau d'atténuation est indiqué 
dans la boîte sur la droite du bouton.
 
Mute 
En cochant cette case, vous rendez muettes les sorties casque et ligne 
simultanément.

7

8

9

1

2

3
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Maestro
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Contrôle Maestro - Avancées

OUT Muting – Ces cases déterminent quelles sorties sont rendues muettes lorsque 
la fonction Mute est enclenchée. Voici quelques réglages en exemple :

Quand les cases sont cochées comme indiqué sur 
la gauche, vous pouvez basculer entre le mode 
d'enregistrement (casque actif, enceintes branchées sur 
les sorties ligne désactivées) et un mode lecture (casque 
désactivé, enceintes activées) avec une action - activer 
ou désactiver le Mute.  Étant donné que le contrôle 
de volume pour les deux sorties est partagé, il est 
recommandé	de	vérifier	votre	niveau	avant	de	réactiver	
les sorties de ligne.

  
Quand les cases sont cochées comme indiqué sur la 
gauche, les sorties casque ne sont jamais rendues 
muettes	;	quand	Mute est enclenché, seules les sorties 
ligne sont rendues muettes. 

Mic/Instrument gain mode – Ce menu règle le mode de gain d'entrée.
Max. Gain range – La plage complète de gain est disponible, avec un 
interrupteur de relais après les premiers 10 dB de gain. 
Clickless Operation – La plage de gain est réduite légèrement mais 
aucun relais n'est employé, offrant un fonctionnement sans click quelque 
soit le réglage du gain. Une plage de gain appropriée est réglée selon les 
paramètres Input et 48V .

Meters Display
Ce	menu	sélectionne	le	signal	a	affiché	sur	les	indicateurs	en	façade	;	les	
sélections sont Input, Output ou Follow Selection. Quand Follow Selection 
est	choisie,	l'indicateur	d'affichage	suit	l'indicateur	de	réglage	en	façade	;	par	
conséquent, quand IN-1 ou IN-2	est	sélectionné,	l'indicateur	affiche	les	deux	
entrées, quand OUT	est	sélectionné,	l'indicateur	affiche	la	sortie	stéréo.	
 
Over Hold
Quand Over Hold est réglé sur Infinite, l'indicateur de crêtes reste sur "on" jusqu'à 
avoir été effacé par l'utilisateur. Les crêtes peuvent être effacées en cliquant sur 
l'indicateur de crêtes ou en cliquant sur Clear Overs dans le panneau de Maestro 
Mixer. Quand Over Hold est réglé sur 2 seconds, les indications de crêtes 
disparaissent après deux secondes.

Maestro

2

3

4
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Contrôle Maestro – Avancées : Contrôleurs MIDI

Number of MIDI Controllers – Pour accéder au fonction MIDI de Duet, activez 
1 à 4 contrôleurs MIDI virtuels grâce à ce compteur. Une fois qu'1 ou plusieurs 
contrôleurs	MIDI	sont	activés,	ils	peuvent	être	modifiés	par	le	bouton	en	façade	ou	
le bouton logiciel correspondant. Pour sélectionner un contrôleur MIDI en utilisant 
le	bouton	rotatif,	pressez	le	bouton	jusqu'à	ce	que	le	pop-up	de	Duet	affiche	la	
sélection du contrôleur MIDI désiré (voir p. 16 pour en savoir plus sur les pop-ups 
de Duet). Remarquez que lorsque les contrôleurs MIDI sont sélectionnés, aucun 
des témoins en façade (IN-1, IN-2 ou OUT) ne sont allumés.

Quand Number of MIDI Controllers est réglé sur 1 à 4, les paramètres suivants 
sont accessibles.

MIDI encoder – Ce bouton rotatif logiciel est utilisé pour envoyer des 
données de contrôleur MIDI ou de transport aux applications logiciel

Quand le menu de fonction est réglé sur Controller, les paramètres suivants sont 
accessibles :

Number	–	Cette	case	affiche	le	numéro	MIDI	Continuous	Controller.		 
La plage complète de contrôles 7 bits (0 à 127) peut être saisie.
Chan 	–	Cette	boîte	affiche	le	canal	MIDI	sur	lequel	les	données	de	
contrôleur sont envoyées. Des numéros entre 1 et 16 peuvent être saisis.
Value – Les numéros dans la plage 0-127 peuvent être directement 
saisis (suivi des touches Enter ou Return pour accepter la valeur), bien 
que la rotation du bouton surpasse l'entrée numérique.

Quand le menu de fonction est réglé sur Song Position, le réglage suivant est 
accessible :

1/4 Note	–	Cette	boîte	affiche	l'emplacement	actuelle	dans	la	chanson	
comme	défini	par	le	numéro	de	notes	depuis	le	début	du	morceau.

Maestro
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Maestro

Mélange basse latence

Avant de décrire les fonctions du panneau du Mixer de Maestro, quelques informations 
de	fond	sur	la	latence	et	les	configurations	d'enregistrement	numériques	assistées	par	les	
ordinateurs vous aideront à mieux comprendre ces fonctions.

Lors de l'enregistrement avec des applications audio numérique informatisée, le délai 
entre l'entrée et la sortie du système d'enregistrement perturbe souvent le timing de 
l'interprétation	des	musiciens.	Ce	délai,	appelé	latence,	signifie	que	le	musicien	écoute	les	
notes qu'il produit quelques millisecondes après les avoir joué. Comme tous ceux qui ont 
parlé au téléphone avec un écho savent, des délais relativement courts peuvent brouiller le 
timing d'une conversation, parlée ou musicale.

Pour illustrer l'effet de la latence, l'illustration A dépeint la route typique du signal d'une 
session d'overdub vocale. Un vocaliste chante dans un microphone, qui est dirigé ver 
un convertisseur analogique-numérique, puis ver une application logiciel audio pour 
l'enregistrement. Dans l'application logiciel, le signal en direct du vocaliste est mélangé 
avec le playback des pistes enregistrées préalablement, dirigé vers un convertisseur 
numérique-analogique,	et	finalement	dirigé	vers	le	casque	du	vocaliste.	Un	léger	délai	
s'accumule à chaque étape de conversion, alors qu'une quantité plus importante de 
délai est ajouté lors du passage dans l'application logiciel. Le vocaliste entend alors son 
interprétation avec un délai de quelques millisecondes. 

Illustration 1

Illustration 2

Illustration B

Interface  
matérielle

Melangeur  
basse latence

Piste activée pour 
l'enregistrement

Sortie du DAW

Latence   

Latence  Latence  

Latence  

Logiciel  
audio

Interface  
matérielle

Piste activée pour 
l'enregistrement

Sortie du DAW

Latence  

Latence  Latence  

Latence   

Logiciel  
audio
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Mélange basse latence - suite

En dirigeant l'entrée matériel directement dans la sortie matériel et en mélangeant le 
playback tel qu'indiqué sur l'illustration B, il est possible de fournir au vocaliste un signal de 
suivi au casque avec un délai bien plus réduit. 

Premièrement, le signal enregistré (dans ce cas, le micro voix) est divisé juste après la 
conversation A/N et dirigé vers l'application logiciel pour sont enregistrement et directement 
vers	les	sorties	matérielles	sans	devoir	passer	par	le	logiciel	qui	ajoute	de	la	latence	;	cela	
permet d'obtenir une route basse latence du micro au casque. Puis, un mélange stéréo 
des pistes de playback est dirigé vers le mélangeur basse latence et combiné avec les 
entrées(s) matériel. Cela permet à l'interprète de s'écouter sans délai troublant tout en 
écoutant les pistes de playback de façon à pouvoir enregistrer ses overdubs.

Veuillez remarquer que le mélangeur de l'application logiciel est utilisé pour créer un 
mélange des pistes de playback alors que le mélangeur basse latence est utilisé pour créer 
un équilibre entre le mélange de playback stéréo et les entrées hardware.

Maestro

Illustration 1

Illustration 2

Illustration B

Interface  
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Melangeur  
basse latence

Piste activée pour 
l'enregistrement

Sortie du DAW

Latence   
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Logiciel  
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Latence  Latence  

Latence   

Logiciel  
audio
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Maestro Mixer

Le mélangeur de Maestro fournit la possibilité de mélanger les entrées matériel de Duet 
avec	la	lecture	provenant	d'une	application	audio	et	dirige	le	mélange	final	vers	les	sorties	
matériel de Duet. Grâce au mélangeur de Maestro, il est possible de créer un mélange où 
la latence n'est pas un problème.

Input 1, Input 2 – Ces canaux 
fournissent des possibilités de 
mélange pour diriger et mélanger 
le signal de chaque entrée matériel 
de Duet directement sur les sorties 
matériel de Duet. La source d'entrée 
est déterminée par le réglage 
d'entrée (p. 12).

From Mac  - Ce canal fournit 
des possibilités de mélange pour 
mélanger la sortie d'une application 
audio avec les sorties matériel de 
Duet.  

To Hardware – Ca canal fournit un 
niveau de sortie du mélangeur et du 
routage. 
 
Quand To Hardware est réglé dans 
Out L-R, la sortie du mélangeur est 
envoyé vers les sorties matériel de 
Duet.

Quand To Hardware est réglé sur 
None, le mélangeur est désactivé 
et la sortie de l'application audio est 
envoyée directement vers les sorties 
matériel de Duet, sans passer par le 
mélangeur de Maestro. 

Maestro

1

2

3

1 2 3
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Travailler avec le Mixer de Maestro

Est-ce que j'ai besoin du Mixer de Maestro ?
Le mélangeur de Maestro sert à fournir un mélange de suivi basse latence alors que vous 
enregistrez. Par conséquent, si vous utilisez Duet pour écouter iTunes ou de l'audio d'un 
autre programme, vous n'avez pas besoin du mélangeur. Réglez To Hardware sur None 
pour désactiver le mélangeur.

Il	est	possible	que	la	latence	de	votre	système	d'enregistrement	singulier	soit	suffisamment	
basse pour ne pas être un probable. La latence du système est déterminée par le réglage 
du	tampon	du	logiciel	d'enregistrement	et	si	votre	Mac	est	suffisamment	puissant,	il	est	
possible de régler le tampon sur une valeur faible (latence plus courte) sans provoquer de 
cliquetis et de craquements dans la sortie audio. Si la latence n'est pas un problème lors de 
l'enregistrement, le mélangeur peut être désactivé en réglant To Hardware sur None.

Paramètres du logiciel d'enregistrement
Avant d'utiliser le mélangeur de Maestro, il est nécessaire de changer quelques paramètres 
de votre logiciel d'enregistrement. 
Software monitoring - Étant donné que le signal à enregistrer est suivi via le mélangeur 
Maestro, les sorties des pistes du logiciel enregistrant doivent être désactivées - après 
tout, ce sont elles qui provoquent la latence. La plupart des applications logiciel fournissent 
une option pour couper le suivi des pistes d'enregistrement. Dans Logic Pro, par exemple, 
l'option de suivi logiciel se trouve dans la même fenêtre Audio Preferences utilisée pour 
sélectionner Duet en tant que dispositif matériel (Logic Pro > Preferences > Audio). 
Décochez la case de Software Monitoring.
Playback mix - Dans votre logiciel d'enregistrement, paramètrez un mélange de toutes 
les pistes de playback et routez-les vers Out L-R. Si un curseur master contrôle la sortie 
globale du mélange, nous vous recommandons de le régler sur 0 dB. 

Paramètres de Maestro
Maestro Mixer settings - D'abord, réglez l'Input, curseurs From Mac et To Hardware  
sur 0 dB. Réglez le menu To Hardware sur Out L-R. 
Après avoir effectué la sélection de l'entrée et avoir réglé le gain (tel que décrit en page 
12),	le	signal	devrait	s'afficher	sur	les	indicateurs	Input	et	To	Hardware.	Si	le	témoin	de	
crête Input s'allume, réduisez le gain d'entrée dans la fenêtre Maestro Control. Si le témoin 
de crête To Hardware s'allume, réduisez le curseur Input. 
Lancez la lecture depuis la session. Le signal de playback devrait apparaître sur les 
indicateurs From Mac et To Hardware. Utilisez les curseurs From Mac et Input pour établir 
une balance entre les signaux d'entrée et du playback. Si vous trouvez un bon équilibre 
mais que le témoin de crête To Hardware s'allume, réduisez le curseur To Hardware. 
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Maestro

Préférences de Maestro – Préférences de Duet

Les	deux	préférences	Maestro	spécifiques	à	Duet	sont	décrites	ci-dessous.	Pour	une	
description des autres réglages de préférences, veuillez-vous reporter à la page 24.

Launch Maestro automatically when connecting a device (Lancement automatique 
de Maestro lors du branchement d'un dispositif) 
Quand cette case est cochée, Maestro se lance automatiquement quand Duet est détecté 
sur	le	bus	firewire	du	Mac.	De	façon	à	pouvoir	rappeler	les	réglages	de	mélangeur	de	
Maestro une fois l'ordinateur redémarré, cette case doit être cochée. Si cette préférence 
n'est pas cochée, les réglages du mélangeur de Maestro ne seront pas conservés une fois 
le Mac éteint ou redémarré.

Enable Duet pop-ups (Autoriser les pop-ups de Duet)
Quand	cette	case	est	cochée,	les	pop-ups	du	bouton	apparaissent	sur	le	Mac	qui	affiche	
plusieurs réglages de Duet, comme les niveaux d'entrée et de sortie, l'Input, le Group et le 
muting. Pour vous expliquer, voici quelques exemples :

IN-1 sélectionné,  
Input réglé sur  XLR Mic,  
bouton réglé sur 40 dB

IN-1 et IN-2 sélectionnés,  
Group coché,  
Input 1 réglé sur XLR Mic,  
Input 2 réglé sur Instrument,  
encoder 1 réglé sur 30 dB,  
encoder 2 réglé sur 40 dB.
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Maestro

OUT Level réglé sur –12 dB 
Mute enclenché 
OUT muting réglé comme montré ci-dessous

Mute enclenché, 
OUT muting réglé comme montré ci-dessous

Bouton	réglé	pour	modifier	le	MIDI	Controller	1
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Maestro

Contrôles des potentiomètres
Mouse motion	–	Cette	sélection	définit	le	déplacement	de	la	souris	qui	règle	les	
potentiomètres.
Fine adjust key	–	Cette	sélection	définit	le	contrôle	clé	pour	effectuer	les	réglages	fins	
des potentiomètres. 

Contrôles des curseurs
Fine adjust key -	Cette	sélection	définit	le	contrôle	clé	
pour	effectuer	les	réglages	fins	des	curseurs.
0dB key	–	Cette	sélection	définit	la	commande	clé	pour	
régler le curseur sur 0 dB quand vous cliquez sur la 
fenêtre de valeur de niveau.
Ungroup faders -	Cette	sélection	définit	la	commande	
clé pour régler un des côtés des curseurs From Mac et 
To Hardware stéréos.

Contrôles de panoramique
Fine adjust key	–	Cette	sélection	définit	le	contrôle	
clé	pour	effectuer	les	réglages	fins	des	contrôles	de	
panoramique.
Center	-	Cette	sélection	définit	le	contrôle	clé	pour	
régler le contrôle de pan sur <0>, ou centré, quand vous 
cliquez sur la fenêtre de valeur de pan.

Autres
Mute/Solo all	-	Cette	sélection	définit	le	contrôle	clé	pour	engager	tous	les	mutes	ou	
solos quand vous cliquez sur les boutons Mute ou Solo.

Préférences supplémentaires
Launch Maestro automatically when connecting a device - Quand cette case est 
cochée, Maestro se lance automatiquement quand Duet est détecté.

Maestro > About Maestro
Sélectionnez cet élément du 
menu  pour ouvrir une fenêtre 
sur la droite, qui indique les 
différentes versions de logiciel et 
de	firmware.	

Menu par Menu

Maestro > Preferences
Sélectionnez cet élément du menu pour ouvrir une fenêtre Preferences dans laquelle vous 
pouvez	définir	l'action	des	contrôleurs.
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Maestro

Menu par Menu

Maestro > Hide Maestro
Sélectionnez cet élément du menu pour occulter l'application Maestro.

Maestro > Hide Others 
Sélectionnez cet élément du menu pour occulter toutes les autres applications ouvertes.

Maestro > Show All
Si Hide Others a été préalablement sélectionné, choisissez cet élément du menu pour 
afficher	toutes	les	applications	ouvertes	dans	le	Finder.

Maestro > Quit Maestro 
Sélectionnez cet élément du menu pour fermer l'application Maestro.

File:
File > Open
Sélectionnez	cet	élément	du	menu	pour	naviguer	parmi	les	fichiers	de	configuration	
Maestro conservés et en ouvrir un.

File > Open Recent 
Sélectionnez	cet	élément	du	menu	pour	rouvrir	un	fichier	de	configuration	Maestro	
ouvert récemment.

File > Close Window 
Sélectionnez cet élément du menu pour fermer la fenêtre "active" ou au premier-plan.

File > Save 
Sélectionnez cet élément du menu pour conserver les paramètres en cours de toutes les 
fenêtres.

File > Save As
Sélectionnez cet élément du menu pour conserver les paramètres en cours de toutes les 
fenêtres	dans	un	fichier	nouveau.
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Maestro

Window:
Window > Minimize

Sélectionnez cet élément du menu pour réduire la fenêtre au premier plan dans le 
Dock OS.

Window > Zoom
Sélectionnez cet élément du menu pour élargir la fenêtre Maestro active.

Window > Bring All to Front
Sélectionnez cet élément du menu pour placer toutes les fenêtres de Maestro au 
premier plan.

Tools:
Tools > Maestro Control

Sélectionnez cet élément du menu pour ouvrir la fenêtre de Maestro Control.
Tools > Maestro Mixer

Sélectionnez cet élément du menu pour ouvrir la fenêtre de Routing/Mixer.
Tools > Reset Symphony Clocking

Dans certains cas, les interfaces Apogee ne peuvent être détectées jusqu'à ce que les 
paramètres de l'horloge de la première interface n'ait été réinitialisés. Sélectionner Reset 
Symphony Clocking, vous permet de réinitialiser la source d'horloge dans la première 
interface sur Internal ou External.

Tools > Refresh Connections
Sélectionnez	cet	élément	du	menu	pour	revérifier	le	matériel	Apogee	connecté	sur	
l'ordinateur.

Tools > Reset Mixer
Les	mélangeurs	Maestro	peuvent	être	réinitialisés	avec	cet	élément	du	menu	;	sélectionnez	
Reset	Displayed	pour	réinitialiser	le	mélangeur	affiché	dans	la	fenêtre	Maestro	Mixer	;	
sélectionnez Reset All to reset all mixers.

Tools > Reset Routing
Sélectionnez cet élément du menu pour réinitialiser les panneaux d'entrée et de sortie dans 
une	configuration	“pass	through”,	où	les	E/S	matériel	et	logiciel	sont	reliées	une	par	une.

Menu par Menu
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Branchez les enceintes sur les sorties 

1/4” avec les  icones  étiquetées 

OUT-L et OUT-R sur le câble épanoui.

Branchez le casque sur la 

sortie 1/4” mm avec l'icon  .

Brancher votre Duet 

Enceintes et casque

Si vos entrées de suivi 

ou entrées stéréo sont du 

type RCA, veuillez utiliser 

les adaptateurs inclus 

pour faire la connexion. 

Branchez l'adaptateur sur 

les connexions OUT-L 

et OUT-R du câble 

épanoui de Duet, puis 

connectez le câble RCA.
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Brancher votre Duet 

Instrument et Mic

Branchez un instrument sur 

l'entrée 1/4”  avec  

l'icône   étiquetée IN-1 

sur le câble épanoui.

Branchez un microphone sur  

l'entrée XLR avec l'icône    

étiquetée IN-2 sur  

le câble épanoui.
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Brancher votre Duet 

Instrument et Instrument

Branchez un instrument sur l'entrée 

1/4” avec l'icône    étiquetée 

IN-1 sur le câble épanoui.

Branchez un instrument sur l'entrée  

1/4” avec l'icône    étiquetée 

IN-1 sur le câble épanoui.
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Brancher votre Duet 

Mic et Mic

Branchez un microphone sur 

l'entrée XLR avec l'icône   

étiquetée IN-2 sur le câble épanoui.

Branchez un microphone sur 

l'entrée XLR avec l'icône         

étiquetée IN-1 sur le câble épanoui.



Duet – Manuel de l'utilisateur

31Brancher votre Duet  

Brancher votre Duet

Branchez les enceintes sur les sorties 
1/4” avec les icones  étiquetées 
OUT-L et OUT-R sur le câble épanoui.

Moniteurs alimentés

Duet est aussi la meilleure manière d'écouter de l'audio depuis votre Mac, que ce soit 
depuis une bibliothèque iTunes, une station radio internet ou la lecture d'un CD/DVD.

Pour brancher les sorties ligne de Duet directement sur des enceintes alimentées, vous 
aurez besoin de 2 câbles avec des prises 1/4” à une extrémité pour brancher les prises 
OUT-L  et OUT-R  de Duet et le connecteur adéquat sur les autres extrémités pour le 
branchement sur vos enceintes. Pour plus de facilité, 2 adaptateurs 1/4” / RCA sont 
inclus avec Duet, vous permettant d'utiliser des câbles RCA/RCA traditionnels pour le 
branchement sur votre équipement stéréo conventionnel.

Quand vous vous branchez sur des enceintes alimentées, utilisez le bouton de Duet pour 
contrôler le volume de lecture.
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Branchement sur une chaîne stéréo 

Pour brancher Duet directement sur votre système home audio, insérez les adaptateurs 1/4” 
vers RCA sur les prises OUT-L et OUT-R de Duet et utilisez un câble traditionnel RCA vers 
RCA pour brancher sur l'entrée AUX ou CD de votre récepteur. 

Lors de la connexion sur un système home audio, réglez la sortie de Duet sur 0 dB (p.e. 
volume maximum) et utilisez le contrôle de volume du récepteur pour régler le niveau de 
lecture.

Une fois les connexions audio effectuées, connectez le port FireWire de Duet sur votre 
Mac. Une fois branché, la boîte de dialogue montrée ci-dessous apparaît.  Cliquez Yes pour 
choisir Duet for Mac sound output et input.

Cette sélection peut aussi être effectuée dans le panneau System Preferences >  
Sound > Output.

Dans iTunes, sélectionnez Computer comme sortie audio. Tout audio joué dans iTunes sera 
désormais dirigé vers Duet et la sortie sera disponible sur votre système home audio.
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Dépannage

Q : Quand je presse le bouton pour sélectionner une entrée ou une sortie, la sélection est 
indisponible. Pourquoi ? 

R : Quand les entrées sont réglées sur XLR line ou que la sortie est réglé 
sur Instrument Amp, le bouton est désactivé et, par conséquent, n'est pas 
sélectionnable.

Q : Quand je presse le bouton pour sélectionner une entrée ou une sortie, TOUS les 
témoins s'éteignent. Pourquoi ? 

R : Quand un ou plusieurs contrôleurs MIDI sont activés et sélectionnés pour 
contrôle par le bouton en façade, tous les témoins d'E/S en façade s'éteignent 
pour indiquer la sélection d'un contrôleur MIDI. Si les pop-ups sont activés dans 
les	préférences	Maestro,	le	contrôleur	MIDI	sélectionné	s'affiche	sur	l'écran.

Q : J'ai	branché	ma	guitare	mais	je	n'obtiens	aucune	entrée.	Que	dois-je	vérifier	?
R : Dans Maestro, assurez-vous d'avoir réglé Input sur Instrument.

Q : Je	n'obtiens	aucune	sortie	depuis	les	applications	logiciel	audio.	Que	dois-je	vérifier	?
R : Si le témoin OUT clignote, la sortie est rendue muette. Pressez et 
conservez enfoncé le bouton en façade jusqu'à ce que le témoin OUT arrête de 
clignoter. De plus, si la sortie mélangeur de Maestro a été réglée sur Out L-R, 
le curseur From Mac doit être manipulé pour envoyer les sorties de l'application 
logiciel audio vers les sorties de Duet.

Q : Je souhaite que Maestro s'ouvre automatiquement à chaque fois que je connecte Duet. 
Que dois-je régler ?

R : Ouvrez Maestro > Preferences et cochez la case Launch Maestro 
automatically when connecting Duet.

Q : Puis je régler les sorties casque et ligne à des niveaux différents ?

R : Les sorties casque et ligne sont toujours contrôlées simultanément. Pour 
régler la balance entre les enceintes et les écouteurs branchés, réglez l'ampli 
des enceintes en fonction. Il est possible de rendre muet les sorties ligne et 
casque indépendamment.

Q : Comment puis-je réinitialiser Duet ?

R : Pour réinitialiser Duet, pressez et maintenez enfoncé le bouton pendant 5 
secondes. Tous les paramètres retournent à leur état par défaut.
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Utilisation de Duet avec Apple Soundtrack Pro

Sélectionnez Soundtrack Pro >  Preferences.

Cliquez sur l'onglet Recording.
Sélectionnez Duet dans les menus Input et Monitor.
Fermez la fenêtres des Preferences après avoir 
réalisé les réglages.

Utilisation de Duet avec Apple MainStage

Sélectionnez MainStage > Preferences

 

Cliquez sur l'onglet Audio/Midi
Sélectionnez Duet dans les menus Audio Output et 
Audio Input
Réglez I/O Buffer Size sur 128
Fermez la fenêtres des Preferences après avoir 
réalisé les réglages.

Pour contrôler Duet directement dans votre session 
Mainstage, choisissez Mainstage > Open Apogee 
Control Panel.

Guide des applications Core Audio



Duet – Manuel de l'utilisateur

35Dépannage

Utilisation de Duet avec Apple Final Cut Pro

Choisissez Final Cut Pro > Audio/Video Settings.

Cliquez sur l'onglet A/V Devices.
Sélectionnez Duet dans le menu Audio.
Cliquez sur OK.

 

Utilisation de Duet avec Ableton Live

Sélectionnez Live >  Preferences

Cliquez sur l'onglet Audio-
Sélectionnez CoreAudio dans le menu Driver Type.
Sélectionnez Duet dans les menus Audio Input 
Device et Audio Output Device.
Réglez Buffer Size sur 128.
Fermez la fenêtres des Preferences après avoir 
réalisé les réglages.

Guide des applications Core Audio
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Utilisation de Duet avec MOTU Digital 
Performer

Sélectionnez	Setup	>	Configure	Audio	System	>	
Configure	Hardware	Driver
 

Dans	la	fenêtre	Configure	Hardware	Driver,	
sélectionnez CoreAudio dans le menu du dessus.
Sélectionnez Duet dans la liste des dispositifs.
Réglez Buffer Size sur 128.
Réglez Host Buffer Multiplier sur 1.
Réglez Work Priority sur Low.
Cliquez sur OK.

  

Utilisation de Duet avec Steinberg Nuendo

Sélectionnez Devices > Device Setup

Dans la fenêtre Devices, cliquez sur VST Audio 
System.
Sélectionnez Duet dans le menu ASIO.

Une fois Duet reconnu par Nuendo, sélectionnez 
Duet dans la fenêtre Devices.
Cliquez sur Control Panel.
Dans le pop-up ASIO Settings, réglez Buffer Size sur 
128 et cliquez sur OK.
Dans la fenêtre Device Setup, cliquez sur OK.

Guide des applications Core Audio
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Options et caractéristiques

Deux canaux d'entrée et sortie audio de qualité professionnelle 24-bit/96kHz•	
Deux entrées XLR symétriques avec une alimentation fantôme 48 V activable pour •	
chaque entrée
Réglage	Maximum	input	-	+4	dBu	:	20	dBu	;	Réglage	-10	dBV	:	+8	dBV•	
Gain Mic Pre-amp : de 10 à 75 dB•	
Deux entrées instrument haute impédance asymétriques•	
Une sortie casque stéréo haut niveau•	
Deux sorties ligne -10 dBV asymétriques pour les enceintes alimentées•	
Un bouton de contrôleur multi-fonction pour le contrôle du gain et du volume et un contrôle •	
MIDI programmable
Des	indicateurs	LED	multi-segments	pour	afficher	les	niveaux	d'entrée	et	de	sortie•	
FireWire 400, compatible avec Mac OS X Core Audio•	
Intégration et contrôle avec GarageBand, Logic Pro, Logic Express  •	
and Final Cut Studio (Soundtrack Pro) d'Apple
Compatible avec toute application audio compatible Core Audio•	
Le logiciel Maestro d'Apogee pour un contrôle avancé et un mélange basse latence•	

 
Configuration système 

Ordinateur : Mac G4 1G Hz ou plus rapide, PPC ou Intel CPU  
Mémoire : 1 Go RAM minimum, 2 Go recommandé
OS X : 10.4.11 ou supérieur installé, 10.5.3 ou supérieur chaudement recommandé.
Connexion : port FireWire 400
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Remarques

Enregistrement du propriétaire

Le numéro de série est situé sur le panneau arrière de l'unité. Nous vous conseillons de noter le numéro 
de série dans l'espace fourni ci-dessous. Indiquez-le à chaque fois que vous vous mettez en contact avec 
un réparateur Apogee Electronics agréé ou le fabricant. Assurez-vous de bien retourner votre bon de 
garantie dès maintenant !

Nº série Duet.________________________________________________________________________

Date d'achat________________________________________________________________________
 
Revendeur_________________________________________________________________________

Téléphone__________________________________________________________________________

Adresse_____________________________________________________________________________

ATTENTION :
Tous	les	changements	ou	modifications	sans	autorisation	exprès	d'APOGEE	ELECTRONICS	
CORPORATION peuvent annuler votre droit à utiliser cet équipement selon les normes FCC.

Veuillez enregistrer cette unité en remplissant la carte d'enregistrement fournie ou en ligne à

http://www.apogeedigital.com/register.html 

Avertissements

Avertissement FCC
Cet équipement a été testé et s'est avéré conforme aux limites pour la classe B des appareils 
numériques, selon les termes de la partie 15 des règles FCC. Ces limites sont conçues pour offrir 
une protection raisonnable contre les interférences dommageables dans une installation domestique. 
Cet équipement produit, utilise et peut entraîner un rayonnement d'énergie de fréquence radio et, 
s'il n'est pas utilisé conformément aux instructions, peut causer des interférences dommageables au 
communications radio. L'utilisation de cet équipement dans une zone résidentielle peut provoquer des 
interférences dommageables, dans ce cas l'utilisateur devra prendre les mesures nécessaires pour 
corriger ces interférences à ses frais.

Remarque sur le droit d'auteur

Duet d'Apogee est un dispositif informatique et à ce titre contient et utilise des logiciels sous forme de 
ROM. Ce logiciel et toute la documentation connexe, ce manuel inclus, contiennent des informations 
propriétaires qui sont protégées para les lois sur le droit d'auteur. Tous les droits sont réservés. Aucune 
partie	de	ce	logiciel	et	de	sa	documentation	ne	doit	être	copiée,	transférée	ou	modifiée.	Vous	ne	pouvez	
pas	modifier,	adapter,	traduire,	louer,	distribuer,	revendre	ou	créer	des	travaux	dérivés	en	vous	basant	
sur ce logiciel ou la documentation connexe, tout ou partie, sans un consentement préalable écrit 
d'Apogee Electronics Corporation, U.S.A.
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Informations sur l'enregistrement et la garantie

Assurez-vous d'enregistrer votre Duet, que ce soit en remplissant la Carte d'enregistrement ou en 
remplissant le formulaire d'enregistrement en ligne sur notre site web : http://www.apogeedigital.com/
support/. Dans ce cas, Apogee peut vous contacter avec des informations de mise à jour. Au fur et à 
mesure que des améliorations et des mises à jour sont développées, vous serez contactés à l'adresse 
d'enregistrement. Les mises à jour du Firmware sont gratuites pendant un an, sauf mention contraire. 
Veuillez envoyer vos questions à votre revendeur ou directement à Apogee à :

APOGEE ELECTRONICS CORPORATION, 
1715 Berkeley St, Santa Monica, CA  90404, USA. 
Tel : (310) 584-9394
Fax : (310) 584-9385
Email: support@apogeedigital.com 
Web: http://www.apogeedigital.com

APOGEE ELECTRONICS CORPORATION garantie ce produit sans défaut en matériaux et construction 
pour un usage normal pendant 12 mois. Les termes de cette garantie commence à partir de la date de 
vente. Les unités retournées pour une réparation sous garantie à Apogee ou un centre de réparation 
autorisé seront réparées ou remplacées au choix du fabriquant, sans frais. 
TOUTES LES UNITÉS RETOURNÉES À APOGEE OU UN CENTRE AGRÉÉ DOIVENT ÊTRE 
PRÉPAYÉES, ASSURÉES ET CORRECTEMENT EMABALLÉES,  SI POSSIBLE DANS LEUR BOÎTE 
D'ORIGINE. Apogee se réserve le droit de changer ou d'améliorer la conception à n'importe quel 
moment	et	ce	sans	préavis.	Les	modifications	de	conception	ne	sont	pas	incorporées	rétroactivement	et	
l'incorporation	des	modifications	de	conception	dans	les	unités	futures	n'impliquent	aucune	mise	à	jour	
des unités existantes.

Cette garantie est annulée si Apogee détermine, à son seul jugement, que le défaut est le résultat 
d'abus, de négligence, d'altération ou de tentative de réparation par un personnel non agrée. 

Les garanties ci-présentes remplacent toutes les garanties, exprès ou implicites, et Apogee nie 
spécialement	toutes	garanties	implicite	de	valeur	marchande	ou	d'adéquation	à	un	usage	spécifique.	
L'acheteur reconnait et accepte que la compagnie ne pourra être tenu responsable de tout dégât 
spécial, indirect, accidentel ou consécutif ou de toute blessure, perte ou dégât sur une personne ou un 
bien, qui pourrait résulter du disfonctionnement de ce produit. 

Certains états n'autorisent pas l'exclusion des garanties implicites ou des limitations dans la durée d'une 
garantie implicite, par conséquent les limitations ci-dessus ne s'appliquent pas à vous. Vous pouvez 
disposer d'autres droits qui varient d'un état à l'autre. 

Information sur la maintenance

Duet contient des composants qui ne peuvent être entretenus par l'utilisateur : contactez un personnel 
qualifié	pour	toute	réparation	ou	mise	à	jour.	Votre	garantie	sera	annulée	si	vous	manipulez	les	
composants internes. Si vous avez des questions concernant les normes décrites, veuillez contacter 
Apogee. 

Dans le cas où votre Duet requiert une mise à jour ou une réparation, il est nécessaire de contacter 
Apogee avant l'expédition. Un numéro Return Materials Authorization (RMA) vous sera affecté. Ce 
numéro vous servira de référence et facilitera le retour. Apogee requiert que les expéditions soient 
prépayées et assurées - sauf mention contraire négociée à l'avance. 

IMPORTANT : TOUTE EXPEDITION NON PRÉ-PAYÉE OU SANS NUMÉRO RAM NE SERA PAS 
ACCEPTÉE. 
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Déclarations de conformité

Ce dispositif est conforme à la partie 15 du FCC Rules. Le fonctionnement est soumis à deux conditions : 
1. Ce dispositif ne doit pas provoquer d'interférence dommageable
2.  Ce dispositif doit accepter les interférences reçues, même celles qui pourraient provoquer un 

fonctionnement non désiré.

Cet équipement a été testé et s'est avéré conforme aux limites pour la classe A des appareils 
numériques, selon les termes de la partie 15 des règles FCC. Ces limites sont conçues pour offrir 
une protection raisonnable contre les interférences dommageables dans une installation domestique. 
Cet équipement produit, utilise et peut entraîner un rayonnement d'énergie de fréquence radio et, 
s'il n'est pas utilisé conformément aux instructions, peut causer des interférences dommageables au 
communications radio. Si cet équipement produit en effet des interférences dommageables à la réception 
radio ou télévisuelle, ce qui peut être établi en éteignant et rallumant l'équipement, l'utilisateur est 
encouragé à essayer de corriger les interférences en appliquant les mesures suivantes :

1.  Réorientez ou déplacez l'antenne réceptrice.
2.  Augmentez la séparation entre l'équipement et le récepteur.
3.  Connectez l'équipement sur une prise appartenant à un circuit différent de celui auquel le récepteur 

est connecté.
4.  Consultez le vendeur ou un technicien expérimenté dans le domaine radio/TV pour obtenir une 

assistance.

REMARQUE : L'utilisation d'un câble non-blindé avec cet équipement est interdite.
ATTENTION	:	Les	changements	ou	les	modifications	non	expressément	approuvés	par	le	fabricant	peut	
annuler le droit de l'utilisateur à utiliser cet équipement.

Apogee Electronics Corporation, Betty Bennett, CEO.

Industry Canada Notice

This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations. Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le 
matériel brouilleur du Canada.

Déclaration de conformité – CE

Apogee Electronics Corporation déclare par la présente que ce produit, le Duet, auquel ce document fait 
référence, est un matériel en conformité avec les standards et normes suivantes :

 EN55022:1998, EN55024:1998 
 
 EN61000-3-2, EN61000-3-3, EN61000-4-2, EN61000-4-3, EN61000-4-4, EN61000-4-5,  

EN61000-4-6, EN61000-4-8, EN61000-4-11

Déclaration de conformité – Japon

Apogee Electronics Corporation déclare par la présente que le Duet, auquel ce document fait référence, 
est un matériel en conformité avec le standard de Classe B VCCI.

Déclaration de conformité – Australie/Nouvelle Zélande

Apogee Electronics Corporation déclare par la présente que le Duet est un matériel en conformité avec le 
standard AN/NZS.
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